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Cviceni 2

Vicerozmerné normalni rozdéleni
a vicerozmerny t-test
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Vicerozmerne normalni
rozdéleni
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Frequency

Motivace

Histogram Hustota jednorozmérného
normalniho rozdéleni

30

20

I

O—l

| | | | | | | |
60 65 70 75 80 8 90 95

Diastolicky tlak



Motivace — pokracovani

Dvourozmeérny Hustota dvourozmérného
histogram normalniho rozdéleni




Vicerozmeérné normalni rozdeéleni

Hustota jednozmérného normalniho rozdéleni:

1 (x —p?
f(X) — ,—(27_[)0_2 " exp <_ 252 )

L - stfedni hodnota 02 — rozptyl

Hustota vicerozmeérného normalniho rozdéleni:

T p— ( ~(x— )T 27 ))
X1, e, Xp) = cexp|l —=(x—u X— U

v T\ 2

I - vektor stfednich hodnot X - kovarianc¢ni matice

Hustota dvourozmeérného normalniho rozdéleni:

1 exp [ - 1 (z — pz)? L= i) 2p(x — pa)(y — pty)
2no,0y/1 —p% 2(1 — p?) o2 o2 020 1

Yy
[ 5 o2  po.o, p - korelace meziXay;
2 T - \po.oy O, o — smérodatnd odchylka

flz,y) =

¥
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Hustota u nekorelovanych a korelovanych proménnych

Nekorelované proménné
(I"ll = Hz = OI 0-]_ = 02 =1;
p=0)

Korelované proménné
(I"ll = IJ-Z = OI 0]_ = 02 =1;
p=0,5)

Xl MU e,
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Vicerozmeérny prumeér a kovariancni matice

e vicerozmérny primér (napf. pro datovy soubor se 2 proménnymi):

[1 n 1o
LY 1T

* vybérova kovarianéni matice (napf. pro datovy soubor se 2 proménnymi):

S11 Si12
s:[

1
kde s{; = —Y" (X1 — Xq)?
So1 SZZII 11 n— l—l( 1 1)

1
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Vypocet rozptylu a smérodatné odchylky - opakovani
L

* Priklad ctvercl odchylek od priiméru pro n = 3.
* Rozptyl je mozno znacné ovlivnit odlehlymi pozorovanimi.

Rozptyl:

1 _
§°=—"——) (x —X)°
n—1iZ:1:

Smérodatna odchylka:

0,269 0,547 0,638 0,733

X, X X, X3

.........
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Ukol 1

* Spoctéte vicerozmeérny prameér a vybérovou kovariancni matici pro soubor
3 subjektd, u nichz byly naméreny hodnoty objemu hipokampu a
mozkovych komor, prficemz namérené hodnoty byly zaznamenany do
nasledujici datové matice:

2 12
: 10}

3 8

X =
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Ukol 1 - feéeni

13¢

Objem Objem g |
ID . ’ S 12 °
hipokampu mozkovych komor = N
g
1 2 12 3 10 X o
4 10 2 ol
3 8 GE_J, 8 °
o)
@) 7 !
1 2 3 4 5
Vicerozmeérny primeér: Objem hipokampu

X an 1zn ] [1 2+ 4+3) ~(12+10 8] [3 10]
X= - X' - X' = — — —_—
n i1 i1 n i1 i2 3( + 4 + ) 3( + -+ )

Kovariancni matice: S = ] kde:

1521 S22
s11= 5 S (in — %2 = 55 (232 + (4=3)2+ (3-3)2) = (1 +1+0) =1
= %12?=1(Xi2 —X)° = 3Tll((lz —10)24 (10— 10)2 + (8 — 10)?) =4
1

_ _ 1
S21 = 512 = ;3 i1 (X1 — X)X = Xp) = a((z —3)(12-10) + S5S = [ 11 _41]
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Ovéreni dvourozmerné normality

Bagplot = ,bivariate boxplot” (tzn. ,dvourozmérny krabicovy graf“)

120

110+

100 | «
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vaha
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60 o

E'D B FrEn

4[}150 15;5 1:50 1é5 1::'0 1::'5 1én 18IE 1§n 155 200 © ¥aha
m Median

wyska 4 Cutliers

v softwaru Statistica: Graphs — 2D Graphs — Bag Plots

L v i¥and ‘.._"ILI
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Ovéereni dvourozmerné normality

vaha

’ \4 7 . ll . .
Vykresleni regulacni elipsy (,,control” elipse):
120
110 | ©
100 | e o ~
- o \\
_ o ] @
80 ¢ 0" g o = 5 /
o B QEB o ;‘
[}
80 ¢ o gu ° gog a
[+] o [+ ] a
o a
70+ oo 9 o @ oo o
8 o o g%, o
Dc DED o
60 | o B° o°B g
cg oo /
501 oo 2 ..x"'aj.
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0 : : : :
140 150 160 170 130 190 200
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v softwaru Statistica: Graphs — Scatterplots — na zalozce Advanced zvolit Elipse Normal
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Normalizace dat

e Pfevod na normalni rozdéleni (normalita je predpokladem rady
statistickych test().

* Napr. logaritmicka transformace: X = In(Y) nebo X = In(Y+1), pokud data
obsahuji hodnotu O

Asymetrické rozdéleni Normalni rozdéleni
fly) f(x)
X =In(Y)
>
Median
-5 (o £
Geometricky primér y Median Pramér In (y)

* Dalsi priklady:
— odmocninova transf. (pro proménné s Poissonovym rozlozenim nebo
obecné data typu pocet jedincu, bunék apod.: X = JY neboX =Y +1
— arcsin transfomace (pro proménné s binomickym rozlozenim)

— Box-Coxova tranformace i
ea W



Dalsi typy transformaci vicerozmérnych dat

standardizace dat

min-max normalizace

centrovani dat

odstranéni vlivu kovariat na jiné proménné

MU ‘:_‘\\-‘,,_’%
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Standardizace dat

e dlvod: prevod proménnych na stejné méritko

* standardizace: z; = xi;x (tzn. odecteni priiméru od jednotlivych hodnot a

podéleni smérodatnou odchylkou)
 promeénné budou mit rozsah priblizné od -3 do 3

e ziskame tim soucasné i tzv. z-skore (které vyjadruje, o kolik smérodatnych
odchylek se i-td hodnota odchylila od priméru)

e pozor: standardizace je nevhodna v pripadé, kdyz proménné nemaji
normalni rozdéleni a kdyz se v datech vyskytuji odlehlé hodnoty!!!

14000 5 ¢
12000 | £3 & g i
10000 | 51
8000 | 1L
soo0 | O —> 0f E
4000 | & ETT‘U ; [
2000 | 3 3l
0 ————— 4 —
=] [] [=] o [=] I=] =] ] [=] o [=] I=]
}I }l }l }l }l “.'-'I }I }l -“-"I }l }l “.'-'I
2 & 2 E §5 I s ® % E § 3
e g E E o a 4 E E o
E 2 8 2 8§ 5 o 5 2 & 2 8§ 3 Medi
x = o [T o Median x = o [T o Median
2 & F T2 25%75% 2 & F T2 [O025%75%
T T Min-Max T T Min-Max

"y ZoN/7 v 4 _ Hp 1 .. : ’;
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Min-max normalizace

e davod: prevod proménnych na stejné méritko

e oproti standardizaci vhodna i na proménné nemajici normalni rozdéleni Ci

obsahujici odlehlé hodnoty

* min-max normalizace: y; =

x;j—min(x)

max(x)—min(x)

* rozsah hodnot proménnych po min-max normalizaci je od 0 do 1

14000
12000 ¢
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s000
6000 +
4000
2000

T © © © © ©
> = > = > =
[ L Y i |
HTII!'EI'."JEIZ'D
2 & g 3 & =
=
E 2 8 2 5 °
T m 5 =
P EE T2 3
o
T

2

o Median
0 25%-75%
T Min-Max

12 ¢
1.0
0.8t
HERENRRE
[m]
o B H W H g
02}
0.0 ¢
_Dlz i i i i i i
E £ £ E E S
2 2 2 2 2 2
ad o = = < o Median
= g £ =& 2 3 [ 25%-75%
= = T Min-Max
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Centrovani dat

odecteni priméru od dat — ziskdme novou proménnou, ktera bude mit
primér roven nule

divod: centrovani je dulezitou podminkou nékterych pokrocilych
statistickych metod (napt. klasifikaCnich)

centrovani: z; = x; — X

14000 | 3000 ¢

12000 } 3 = 2500 f

10000 | fggg'

8000 | mnn:

gooo| O =) 500 |

4000 | = ETTU ol H

2000 | 5 500 t

_ -1000

EI EI ’?W g| E| _EI 1500
2 8 g E g5 3 2000
e 8 E 8 E & tE € £ £ £ €£
FRo= ® o= o= - s & & & & 8
g E £ o & 3 o Median g T A T B o Median
g = = []25%-75% = g 8 ® 3 8 (] 25%-75%
T T Min-Max a = T Min-Max
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Odstranéni vlivu kovariat (tzv. adjustace)

[}
1. V prvnim kroku definujeme regresni model vztahu kovariaty (napfr. véku) a dané proménné
Pro kazdého pacienta je vypocteno jeho reziduum od regresni primky
Reziduum (predstavujici hodnotu parametru po odecteni vlivu véku, jeho primér je 0) je
pficteno k pramérné hodnoté parametru
4. Vysledna adjustovana hodnota ma odecten vliv véku, ale zaroven neni zménéna Ciselna
hodnota parametru
Pidvodni data Adjustovand data
R = T |
e e ] Ve e ] Ve
T T T T I T I | T | | | T |
20 30 40 a0 B0 70 g0 Objem komor 20 30 40 50 B0 70 80 Objem komor
B te - * L B * o
£ . Lt CR L £l C el ql &+
£ BRIt o 2 eyt e o
- R LR S ¥t : : - AR " ! !
9 el 3"‘%3‘%3«- Y - o SN LT AR N T S N : :
S>> :: seg g Oegd ‘Q: * - g_ 1 - > o | % ’.?‘Q“ e ..3.. R o | 1
3 1Zadtoedaatna " < § g .gﬁ"'-‘a SR ]
8 f" *;i"%;. .f". .‘. o ‘. 0.' - i 8 a. /‘ r i?g ™ %& r&; .... - :
< ’o/.'. :2¢U: ., :0’%“.. o, o i e g o | ¢ ...o.. 0.?‘“3 ., :10.". .o . ’o » w0 i i
E {’o - H o:.. . ” . . - : E ....':‘o:o’&...o. o% Te ; B
T | ¢ : 3 wa T T e, ‘ i
o wt? . . 1 o S . R . . : .
O | + * . = _| g O E B * E n o
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Transformace dat pomoci softwaru SPSS |

* Logaritmicka transformace:

Transform -> Compute Variable -> Target Variable: ndzev nové proménné (napr.
vaha_log) -> Function group: Arithmetic -> Functions and Special Variables: vybrat
Ln a pretahnout do okna Numeric Expresssion -> do argumentu funkce vioZime
vybranou proménnou (napr. vaha)

& Age

& Height
& Weight

& MMSE

& Genc transformovana

Ja Gender_rek
&5 gender_01

& Height_cor
& weight_konst
& MMSE_24

& mmse_neg
L. mmea_kat

/

LN(numexpr). Numeric. Returns the base-e logarithm of
numexpr, which must be numeric and greater than 0.

Popis vybrané funkce

-

@(optional case selection condition)

[ ok ][ paste || Reset |(cancel| [ Help |

;_;f Compute Variable e
Nazev nové proménné
Target Variable: Numeric Expression:
|Weight_log g | - [(Nowveignt) ¢mmmmm Definovaninové
promeénné

Type & Label...
# o = R kalkulagka”
&> Group :
&) Group_3kat ) ‘v Function group:
3 G | ‘
&b group |, . Arithmetic
& arouy Vybér promenne, I <= 4 5 6 CDF & Noncentral CDF
& agrou; ktera ma byt Conversion

Current Date/Time \
Date Arithmetic
Date Creation Skupiny funkci

Eunctions and Special Variables:

Abs i

Arsin
Artan
Cos
Exp
Lg10
Ln
Lngamma
Mod
Rnd(1)

skupiny funkei

&

-

e rny
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Transformace dat pomoci softwaru SPSS Il

Standardizace dat:

Analyze -> Descriptive Statistics -> Descriptives -> Variables: vybrat
proménnou (napr. vek) -> zatrhnout Save standardized values as variables
-> 0K

Min-max normalizace:

Transform -> Compute Variable -> Target Variable: zadat jméno nové
proménné (napr. vyska_norm) -> Numeric Expression: vybrat proménnou,
kterou chceme normalizovat, a dopsat vzorecek (napfr. (vyska-155)/(197-155))

Centrovani dat:

Transform -> Compute Variable -> Target Variable: zadat jméno nové
proménné (napr. vyska_centr) -> Numeric Expression: vybrat proménnou,
kterou chceme centrovat, a pridat minus primérnad hodnota (napfr. vyska -
172.24)

Odstranéni vlivu kovariat:

Analyze -> Regression -> Linear -> zvolit proménné (napr. cel_cholesterol jako
Dependent, vek... jako Independent(s)); na zdloZce Save zaskrtnout pri
Residuals: Standardized nebo Unstandardized podle toho, co nam vyhovuje
-> Continue -> OK; pripadné Ize vytvorit novou proménnou pomoci Compute
Variable, kterd bude souctem RES_1 a priméru ptvodni proménné

W ‘:_N 7
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Transformace dat pomoci softwaru Statistica |

[}

* Logaritmicka transformace:
Oznacit proménnou za proménnou, kterou chceme logaritmovat -> kliknout
pravym tlacitkem mysi -> Add Variables -> Name -> zadat ndzev nové
proménné (napr. vaha_log) -> do Long name napsat =Log(vaha) (Pozor,
v softwaru STATISTICA je prirozeny logaritmus oznacen jako Log(x) misto
Ln(x)!) -> OK

* Standardizace dat:
Oznacit proménnou za proménnou, kterou chceme standardizovat -> kliknout
pravym tlacitkem mysi -> Add Variables -> Name -> zadat ndzev nové
proménné (napr. vek_st) -> do Long name napsat =vek -> OK -> Data ->
Standardize... -> OK

* Min-max normalizace:
Oznacit proménnou za proménnou, kterou chceme centrovat-> kliknout
pravym tlacitkem mysi -> Add Variables -> Name -> zadat ndzev nové
proménné (napr. vyska_centr) -> do Long name napsat =(vyska-155)/(197-
155)(minimum a maximum vypocitané pomoci Descriptive statistics) -> OK

W ‘:_,\\ 7
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Transformace dat pomoci softwaru Statistica Il

Centrovani dat:

Oznacit proménnou za proménnou, kterou chceme centrovat-> kliknout
pravym tlacitkem mysi -> Add Variables -> Name -> zadat ndzev nové
proménné (napr. vyska_centr) -> do Long name napsat =vyska-172.24
(primeér vypocitany pomoci Descriptive statistics) -> OK

Odstranéni vlivu kovariat:

Statistics -> Multiple Regession -> zvolit proménné (napr. cel_cholesterol
jako Dependent var., vek... jako Independent variables) -> OK -> OK -> na
zdlozce Save kliknout na Save residuals & predicted -> zvolit proménné, které
bude nové vytvorend tabulka dale obsahovat -> OK

(pfipadné Ize vytvorit novou proménnou pomoci Add Variables, kde v Long
name bude soucet Residuals a priméru ptvodni proménné)
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Vicerozmerny t-test
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Jednorozmeérny dvouvybeéerovy t-test

Srovndavame dveé skupiny dat, které jsou na sobé nezavislé — mezi objekty
neexistuje vazba.

Priklady: srovnani objem hipokampu u muz{ a u Zen, srovnani kognitivniho
vykonu podle dvou kategorii véku,...
2 | %

1 4 I
— —

X1 X2 Pacienti Kontroly

* Predpoklad: normalita dat v OBOU skupinach, shodnost (homogenita)
rozptyll v obou skupinach

7 . . X _X _C . a4 7 \'4 4
o Testova statistika: t=-— : 2 =, kde s, je vaZend smérodatnd odchylka,
S* n7+n7
V 2

c je konstanta, o kterou se rozdil prameért ma lisit (vétSinou rovna 0)

W ‘:_N 7
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Vicerozmerny t-test

Srovnavame dvé skupiny dat, které jsou na sobé nezavislé — mezi objekty
neexistuje vazba.

Na rozdil od jednorozmérného dvouvybérového t-testu jsou dvé skupiny
dat popsany vice kvantitativnimi proménnymi.

0.05-
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Vicerozmerny t-test

Jednorozmeérny dvouvybérovy t-test: - Studentovo rozdélent

CD_ZHC \de Tmt(ny + ny — 2)

e testova statistika: T =

np ng

_ (np— 1)sp+(ng—1)sg
(np—1)+(ny-1)

« cje konstanta, o kterou se rozdil primeérd ma lisit (vétSinou c = 0)

* nulova hypotéza zamitnuta, pokud |T| > t;_, /,(np +ny — 2)

« 52 jevazeny rozptyl vypoéteny jako s2

Je ekvivalentni testu: _ Frozdgleni
2 ()ZD )EH) c 2 _ — 1 1 -1 — 2
T* = (—) = (kp — Xy — ¢) [5*2 (— + —)] (xp — %y —¢), kde T*~ F(1, ny+n,,-2)
/_+_ nNp NH
np ny

Vicerozmeérny t-test:
-1
* Hotellingova T2 testova statistika: T2 = (x, — %y — ¢)T [s* (i + i)] (Xp — Xy — C)
np ny
(np-1)Sp+(ny-1)Sy
(nD—1)+(nH 1)
-p—1 T?
p
* nulova hypotéza zamitnuta, kdyz F > F,_,(p,n—p — 1) <F rozdelem

* kdeS, je vazena kovariancni matice: S, =
Hotellingovo rozdéleni
* T2~ T%p,n-p-1); pro malé nya n,je lepsi pouiit: F =

> kde n=nytn,,



Ukol 2

» Zjistéte, zda se lisi skupina pacientl se schizofrenii od zdravych subjektd na
zakladé parametr( popisujicich objem mozkovych struktur subjektu.

Objem mozkovych komor

13 |
12 |
11 |

A 01 O N © ©

2 12 5 7
Xp=1|4 10|,Xyz=13 9
3 8 4 5
¢ e pacienti
e kontroly
°
[
O
[
°
2 3 4 5 6

Objem hipokampu



Ukol 2

» Zjistéte, zda se lisi skupina pacientl se schizofrenii od zdravych subjektd na
zakladé parametr( popisujicich objem mozkovych struktur subjektu.

2 12 5 7
Xp=14 10, Xy=1|3 9
3 38 4 5
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Ukol 2 - feéeni

Vicerozmérné primeéry: X, =
lgziﬂ Xi1

_ 1 on n
Xy = laziflxn Ezijlxizl =[4 7]

— NP xi| = (3 10]

np

Vybérové kovariancni matice:

D D ) ]

S, — S11 S12| _[1 -1
D~ |.D D | |_

[S21 S22 =1 4|

" H H i _

S, — S11 S12| 1 -1
H ™~ |_H H| |_—

1S21 S22, =1 4.

Vazena kovarianc¢ni matice:

Sy = l—11 _41]

T? = (Xxp —xy — )7 [s(

D

1

— 4+ —
n

Ny

-1
)] (Xp — Xy —¢)



‘ 1 1\
Ukol 2 - fedeni  *=Go-xu-o[s(i+7)| Go-x-0

Vicerozmerné prumery: Xp = Vicerozmé&rny t-test:

1 1
[oI2ixa o TPixe|=13 10] n 6
= _[Lyna o Lyna o P 2
Xp = lnH Zi=1X11 n Zl_lxlzl = [4 7] 72 35
F 1,31
Vybérové kovariancni matice: dfl = p 2
S — sP sl 11 -1 df2 = n-p-1 3
g _351 ng_ =1 4. a 0,05
S _5{11 S{IZ_ T 1 —17 F-crit 9,55
e _5511 Slzqz_ -1 4 p-hodnota 0,389

Vazena kovarianc¢ni matice:

Se = l—ll _41]



Ukol 2 — redeni v softwaru R

install.packages("ICSNP")
library("ICSNP")
Xd=matrix(c(2,4,3,12,10,8),3,2)

Hotelling's two sample TZ2-test

Xh=matrix(c(5,3,4,7,9,5),3,2)
data: Xd and Xh
. T.2 = 1.3125, dfl = 2, df2 = 3, p-value = 0.389%
HOteIlIngSTz(Xd; Xh) alternative hypothesis: true location difference i= not equal to c(0,0)

Pouziti softwaru R jako kalkulacky:

S=solve(2/3*matrix(c(1,-1,-1,4),2,2)) # vypocet inverzni matice

b=matrix(c(-1,3),1,2) # vektor s hodnotami rozdilu souradnic centroid(l
t2=b%*%S%* %t (b) # vypocet testové statistiky T?

F=(3/2)*(t2/4) # vypocet testové statistiky F

gf(0.95,2,3) # 95% kvantil F rozdéleni pro stupné volnosti 2 a 3
1-pf(F,2,3) # p-hodnota



